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Little iDVD Book, Second Edition, The
By Bob LeVitus
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Part 1.  Basic Training

Chapter 3. Introduction to Making DVDs

Now for the moment you've been waiting for—making a DVD with iDVD. After the traditional brief introduction, we'll
look at what it takes to create a DVD, but this time we'll do it tutorial-style.

Like the Apple iDVD tutorial that comes with iDVD (you did go through it, didn't you?), this chapter merely serves as an 
introduction to the program. But we'll actually roll up our sleeves and dig into iDVD itself, looking at the steps it takes to 
go from opening the program to clicking the Burn button. Chapter 4, "Shooting and Editing Tips for Great Video," hardly
talks about iDVD at all—it focuses on the things that happen before you even fire up iDVD like shooting and editing.
After that, we'll get back to iDVD, and look more closely at importing files, creating menus and buttons, adding and
managing audio, creating your own artwork, compression, and lots more.

There's a method to my madness. At least in theory, by the time we get to Chapter 5, "Getting Your Stuff into iDVD,"
(where we go back to iDVD—the program) and chapters beyond, you'll know just how all the pieces go together, and
should have ideas about how you want to assemble and present them with iDVD.

iDVD: It's More Than Just a Program

Before we launch iDVD, let's look at the big picture and how the iDVD software fits into the DVD-making universe. Macs 
equipped with SuperDrives come with QuickTime, iMovie, iPhoto, iTunes, and iDVD all pre-installed, so you have what 
you need to start making movies and DVDs (except for, perhaps, a digital camcorder) as soon as you unpack your new Mac 
and turn it on.

But making a DVD takes a bit more work than merely launching your copy of iDVD and clicking a few times.

Actually, you probably could make a DVD just that easily. It might stink, but you 
could "make a DVD" with that little effort.

iDVD is more than just a program—it's a piece of Apple's cradle-to-grave integrated system for producing DVDs that you
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can view on most home DVD players. Because Apple makes all the parts you use in the DVD-making process—the
hardware, software, operating system, video card, hard disk connection, motherboard, ROMs, and so on—Apple has more
control over how these elements work together than Dell or Gateway or any Windows system manufacturer can ever have.
But iDVD alone is not really enough to make a DVD.

I'm trying to say that DVDs will be much more interesting if you first edit all your raw footage with the included iMovie 
software from Apple.

Or, if you have higher aspirations, you can edit video with a more capable, more 
expensive, nonlinear video editing program like Final Cut Express or Final Cut Pro 
(also from Apple), Adobe Premiere, or Avid Xpress DV.

That's one of the beauties of iDVD—it doesn't care how you edit your video. As long as it's output as QuickTime, it'll
work with iDVD.

The DVD standard requires that video files on DVDs be saved and compressed in the 
MPEG format. MPEG is a data format for compressing digital video into smaller 
files. And while that's really about all you need to know about it, I'd be remiss if I 
didn't tell you at least a little bit more. To wit: iDVD automatically converts your 
content (video, audio, stills, slideshows, and so on) into MPEG format before it burns 
the disc. This conversion takes approximately one to three times the length of the video 
segment, depending on the speed of your Mac and the QuickTime compression scheme 
used when the movie was originally saved.

Here's another example of how iDVD is just part of a bigger system: When you create a video DVD using iDVD you 
import graphics files, video content, and audio tracks, all created by other programs like Adobe Photoshop, Digidesign Pro 
Tools, Bias Peak, Bias Deck, Lemke Software GraphicConverter, iMovie, iPhoto, or whatever program you prefer. Again, 
only after creating all of your "elements" with other software do you use iDVD to assemble those elements, and add 
menus, buttons, slideshows, and other DVD features.

If you think back to the five phases of creating a DVD I mentioned in Chapter 1—plan, create, encode, author, and
record—you'll see that iDVD has little to do with the first two steps. That's because—let's all say it together now: iDVD is
more than just a program—it's a piece of Apple's cradle-to-grave integrated system for producing DVDs.

That system even has a name now—iLife. And in iDVD 3, the pieces have never been so integrated. You now have direct
access to content created in the other iLife applications—iTunes, iMovie, and iPhoto—from within iDVD. It's another
exclusive feature of Apple's cradle-to-grave solution and it's a real timesaver.

Don't panic. We'll be talking about output—compressing and saving and
importing—soon, and it's not as geeky as it sounds here.

Still, you can't just launch iDVD and immediately turn out a studio-quality disc. There's much to be done before you use 
iDVD. In my opinion, it's much better to complete most (or all) of the video, audio, and still image elements before you 
even launch iDVD to put the finishing touches on the job.

Onward.
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iDVD 3: More Better Than Before

It seems unlikely that any of you are still using the first two versions of iDVD, but if you are, you should
consider upgrading to iDVD 3 immediately—it'll be the best $50 you spend on this whole endeavor. Not
just because it's the version this book is about, but because version 3 is more flexible and capable than
versions 1 or 2 and has several desirable new features.

Version 3 has more and better templates (called "Themes," as you'll learn in a few pages) including some 
nifty new ones with ever-so-pro looking "Drop Zones."

And version 3 finally supports honest-to-goodness chapter markers in movies, so your movie can have a 
scene selection menu, just like those fancy store-bought ones from the major movie studios. Sort of.

And as I just said, version 3 is completely integrated with the other iApps, so you can choose a song from 
your iTunes library or a photo from your iPhoto library, all without leaving the comfort of iDVD.

Furthermore, you don't have to do anything special in iMovie to have a movie you can use in iDVD. With 
version 3, your iMovie projects are automatically available to iDVD without having to export them "to 
iDVD" as you had to do in versions 1 and 2.

As always, version 3 has those nifty "motion backgrounds" and "motion menus," so your menu background 
and individual buttons can be movies, not just still images or text. So your finished DVDs will look just 
like fancy store-bought ones from the major movie studios. Sort of.

And, iDVD 3, like iDVD 2 (but not 1, bless its little heart), includes background encoding. As soon as you 
add a movie to your DVD project, the MPEG encoding process starts in the background while you continue 
working, which saves a significant amount of time when you burn the disc.

This is good. (And you have Mac OS X's robust multitasking support to thank for it.)

If you don't already have it, you can get iDVD 3 as part of the package of all four "iApps" that Apple now 
sells as "iLife," at the Apple store online (http://store.apple.com), and other places where fine software is 
sold. Or you can order by phone at 1-800-MY-APPLE.

iLife was priced at $49 when we went to press. That means iDVD 3 is $49, because iPhoto, iMovie, and 
iTunes are free if you don't mind downloading them from Apple. I still think it's worth it for the chapters, 
integration with the other iLife apps, and, of course, for the slick Drop Zone themes.

Importing and Encoding

Now that I've spent several pages explaining why you don't just jump into iDVD without creating some content first, that's 
exactly what I'm going to ask you to do.

You see, iDVD doesn't come with a manual, so Apple recommends you work your way through the included iDVD 
tutorial. It shouldn't take you more than an hour to complete, and it exposes you to many program features in a short time.

But this tutorial is also short on explanations—it shows what to do, but it doesn't provide much detail about why you're 
doing it, or other ways of doing it.
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That's what every hands-on tutorial in this book is shooting for. And, in addition, the tutorials in this chapter are designed 
to get you familiar with iDVD's rich set of features.

Getting started

For this section, we're going to pretend you've already completed Steps 1 and 2—planning the project and creating the
content elements. We'll be using the movies, pictures, and music you received with your copy of iDVD in the Tutorial
folder to simulate those steps.

When you installed iDVD, the tutorial should automatically have been installed in a 
folder called "Tutorial" in your iDVD folder. If you can't find the Tutorial folder on 
your hard disk, try this: Choose iDVD Tutorial from the iDVD Help menu, then click 
the "Open the iDVD Tutorial project and continue" link at bottom left. If it doesn't find 
the Tutorial for you, you may have to reinstall the program. Also, if you've moved the 
iDVD folder (for example, put it in a subfolder of Applications), Help won't be able to 
find it.

Let's open that Tutorial project and get going. You can do this in either of two ways. Here's the first way:

1. Launch iDVD and choose iDVD Tutorial from the Help menu.

2. Click the "Open the iDVD Tutorial project" link at bottom left.
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The second way is even simpler:
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3. From the Finder, open the Start Tutorial Here file in the Tutorial folder.

Whichever method you do, when you're finished, you should have two windows on your screen—the iDVD Help window
and the South Pacific project window, as shown in Figure 3.1.

Figure 3.1. Your screen should now look like this, more or less.
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Finally, click the Next link at the lower right of the iDVD Help window and you're ready to begin.

Importing (and encoding)

After you complete Steps 1 and 2 for your project, the next step is to import that content—your movies, still pictures, and
sound files. While you work on other things iDVD can begin encoding them in the background, as you'll see in a moment.

Right now, I want you to import at least one file so iDVD has something to chew on (encode in the background) while 
you continue to work on the rest of the tutorial.

This isn't a bad habit—importing your movies earlier rather than later. Compression
takes quite a bit of time, so you might as well let the program get to work while you're
doing other things.

The files you're going to use are in the Media folder, in the Tutorial folder, and are shown in Figure 3.2.

Figure 3.2. QuickTime movies, TIFF graphics, and MP3 audio are just some of the types of files you 
can use with iDVD.
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You'll learn more than you want to know about file formats in Chapter 5.

We'll start with the file Background Movie.mov in the Media folder. Choose File > Import > Background Video and select 
the file. When it opens in iDVD, things should look something like Figure 3.3.

Figure 3.3. There's nothing fishy about having a movie playing in the background like this.
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If your screen doesn't look like Figure 3.3, make sure you imported the correct file. 
Also make sure that you didn't choose Import > Video instead of Import > Background 
Video. They're not the same. Click the Motion button to turn on Motion if it's not 
already turned on. Finally, make sure iDVD is currently the active application, not 
Help Viewer.

You should be seeing fish swim and hearing a sweet little jazzy composition. If you're not (but your screen does look like 
Figure 3.3), click the Motion button.

Now, sit back for a second and admire your handiwork. You already have a background movie for your DVD. The 
excitement should last about 38 seconds, which is roughly the length of two repetitions of the movie (it loops 
automatically). When you begin to get sick of it, click the Motion button (again).

Notice how the background movie dims when you turn motion off; that's just one of 
iDVD's elegant touches.

Let's add a normal (non-background) movie. While you could choose Import > Video to do this, I find the drag-and-drop 
method easier. Just drag the movie file Celebration.mov onto the project in iDVD, like this:
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And when you release the mouse, you'll have created a movie button, as shown in Figure 3.4.

Figure 3.4. I know it doesn't look like much yet. But it will.

If Motion is turned off you won't see the dude in the rectangle in the middle—you'll see
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a text message that says "Drag movies or photos here."

Import the other two tutorial movies, Beach.mov and Play Time.mov, using either drag and drop or Import > Video. Let
iDVD chew on them while you get to work on the next step, which is…

If the background encoding makes your Mac feel sluggish (which it may, particularly 
on older Macs), you can turn it off in iDVD Preferences by unchecking "Enable 
background encoding."

Minimize the iDVD window (click the yellow gumdrop) and your movies will be 
encoded somewhat faster.

Authoring

Now it's time for what I consider the fun part: the authoring stage. I define this as, "everything you use iDVD for except 
burning." Since much of what you do in iDVD will change if you change your theme, let's start by looking at themes and 
how they work.

Themes—they're not just for songs and novels anymore

One of the best things about iDVD are the nearly 40 included themes. These themes are professionally designed interface 
shells that you fill with your own titles, movies, sounds, fonts, button shapes and styles, and almost every other visual 
element your DVD will present to the viewer.

But enough jabber. Figure 3.5 shows what these lifesavers look like:

Figure 3.5. The iDVD themes look like this, only much more colorful.
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I was hoping for something a little more elegant in the tutorial than the Theatre theme. Luckily, that's the whole point of 
having themes. To choose a new theme, open the Customize panel (drawer) and select a theme. It couldn't be easier.

To open the Customize panel (drawer):

Choose Show Customize Panel from the Project menu.

Or use the keyboard shortcut Command-Shift-B.

Or click the little Customize button.
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Use one of these methods now and the Customize drawer will pop out of the left side of the main window, as you can see 
in Figure 3.6.

Figure 3.6. The Customize drawer with the Themes pane displayed—this is where the fun begins.

If you've done everything correctly thus far, your project should look something like 
Figure 3.6 right now. If you did as I said earlier and turned off Motion, yours will 
certainly look different (I left Motion on in Figure 3.6 for effect).

If it doesn't look right, go back and reread the earlier sections to see if you can track 
down where you went astray.

I said I wanted elegant, so I selected my favorite, the Global theme, by first choosing Old Themes from the pop-up menu 
then clicking the Global theme, shown in Figure 3.7.

Figure 3.7. Beats the heck out of that fish thing, eh?
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The Old Themes are (surprise!) the themes from iDVD 2; the new ones are new to 
iDVD 3. You can choose from both Old or New themes if you choose All in the pop-up 
menu (instead of Old or New). Also note that if you use the Global theme, the 
background movie (Celebration) you added by dragging it to the drop zone earlier 
won't be there anymore because the Global theme doesn't have a Drop Zone. If you 
then choose a theme that does have a Drop Zone, Celebration will be in it. Nice 
touch.

Try some of the other themes on for size—just click 'em in the Themes panel (pane) and take a peek. The ones with the
little circle-dude in the lower right corner are motion menus. Be sure to turn them on by clicking the Motion button so you
can enjoy the full effect.

When you've peeked all you're going to peek, choose the Global theme again so yours has at least some chance of looking 
like mine in the upcoming pictures.

Menus and buttons and text (oh my!)

Text in iDVD is as easy to deal with as Themes. To change button or menu text, just click the text to select it, like this:
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Then type your replacement text, like this:

That's all there is to it. Feel free to change the title of your project or the title of any or all of the movies in the project 
now.

Next, let's see some motion buttons. When you add a movie to an iDVD project, the button created in the main window is 
automatically a motion-menu button. To see a preview of one now, click the Motion button.

By default, iDVD uses the first frame of the movie as its preview image. (If you've created a poster frame in your 
QuickTime movie, that frame will be used instead.)

To change the still image to another frame in the movie, drag the slider above it, as shown in Figure 3.8.

Figure 3.8. Notice how the picture changes when the slider above it slides.
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What's that you say? You don't see a slider? Ooh… You have to first click a button to
select it; selecting it makes the slider appear.

If you want to remove the motion menu and use a still image on a button instead, just click the button to select it, move 
the slider to the frame you like best, then click the Movie checkbox above the slider to deselect it.

Add some pizzazz with a slideshow

If you have a digital still camera or your camcorder can take decent still pictures (most can't), the iDVD slideshow feature 
is a low-maintenance way to share lots of pictures and present them in a unique manner.

And, as always, iDVD's slideshow feature couldn't be easier to use. Just click the Slideshow button.

Clicking this button will create a new My Slideshow button in your project.

The Fit to Audio option is kind of neat—it times your slideshow to last as long as the
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song you select. So if you have 30 slides and a three-minute song, each slide will
appear for roughly ten seconds. Neat!

Double-click the My Slideshow button to open the slideshow editor window. Then drag the six pictures named Slide 1 
through Slide 6 (from the Tutorial/Media folder) to the slideshow window, as shown in Figure 3.9.

Figure 3.9. Yes, it is this easy to create a slideshow from still images.

Next we'll add background music by dragging the file Slideshow audio.mp3 into the Audio "well," like this:
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Other slideshow options include large or small thumbnail pictures (in the Thumbnail menu), how long each slide remains 
on-screen (in the Slide Duration menu), and whether or not the viewer can click the Next and Previous buttons on screen 
with their mouse to move to the next or previous slide (the "Display during slideshow" checkbox).

It should be fairly obvious that this option only applies if the disc is being viewed on 
a computer. Most televisions don't have a mouse.

All of these items are shown in Figure 3.10.

Figure 3.10. These are the other slideshow options.
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Click the Return button (to get back to the main menu screen), name your slideshow, and use the slider to choose a picture 
to represent it, like this:

Now, let's take a quick look at how to finish things up, so we can move on to the even better stuff.
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The Grand Finale

At this point, imagine that our little project is as done as it's going to get. Now there are only two things left to
do—preview it and burn it.

Not-so-sneaky Preview

Figure 3.11. Dig that genuine simulated, software-emulated remote control!

At approximately $3 a pop for blank DVD-R discs, burning a disc with a mistake on it can get real expensive real fast. 
Fortunately, the preview mode lets you catch mistakes before you burn. Complete with genuine simulated faux remote 
control, the fabulous preview mode lets you test your project before you click the Burn button.

To preview your project, click the Preview button. Presto! A faux remote control appears, allowing you to test your disc 
played on a set-top DVD player.

To exit preview mode, click the Preview button again or click the Exit button on the faux remote.

If you have motion menus in your project, you must turn motion on before you click
Preview or you won't see your motion menus. That's no big deal—just exit preview
mode, click Motion to turn them on, then click Preview again.

But if you don't turn on motion before you burn a DVD, your disc will not have 
motion menus.

In preview mode, use the arrow buttons on the faux remote control to select a button on-screen, then click the Enter button 
to activate it.
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You can also click a button on-screen directly with the Mac cursor to activate it in 
preview mode.

Use the Backward and Forward buttons on the faux remote for slideshows, like Figure 3.12.

Figure 3.12. Click to advance to the next slide.

The arrow buttons on either side of the Enter button on the faux remote also serve 
as Backward and Forward buttons.
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Finally, the Title and Menu buttons on the faux remote return you to the DVD's menu (Title always takes you to the "top" 
menu, and Menu takes you to the last menu you were in).

Although I saved the preview function until near the end of this chapter, you can preview your iDVD project at any time. 
In fact, it's probably a good idea to preview your project every now and then during the authoring phase. I switch back and 
forth often so I know how elements will look on a home DVD player and how they'll respond to clicks on the home 
DVD's remote control.

OK, you now know how to author with iDVD. Sure there are still a lot of cool things you haven't learned yet, like how to 
create your own themes or customize Apple's themes to your own tastes. And you'll learn that soon, but consider this: 
With what you know right now, you could burn a DVD that would impress 99 percent of the people who watch it.

Of course, since it only contains 90 seconds of video right now, they wouldn't stay 
impressed long. But they would almost certainly be impressed with your DVD-making 
skills.

Burn, baby, burn

After you've gone through the preview-and-tweak cycle a few times, you're ready to burn your masterpiece onto a DVD-R 
disc.

Remember—DVD-R discs are write-once discs. Once you burn it, it's burnt. You can't
change anything on that disc. If you make changes to your iDVD project, you have to
burn a new DVD-R disc. Try to avoid costly mistakes.

Now I'm not saying you should waste a perfectly good DVD-R disc on the tutorials we just completed. But if you did
want to burn one now, here's what you would do.

Click the Burn button once. It pulsates to let you know it's awake, as shown in Figure 3.13.

Figure 3.13. The click-and-pulsate effect, captured through the magic of stop-motion animation.

Click the Burn button again and one of two things will happen. Either this:
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As I warned earlier, if you don't turn on motion before you burn a DVD, the DVD will 
not have motion menus. Now iDVD is warning you a second time. Click Cancel and 
turn on motion.

Or this:

This is it. If you insert a blank DVD-R disc now, the burning will happen. I'd like to tell you it happens immediately, but 
it doesn't. How long it takes from clicking Burn to playing the disc on the DVD player in the den depends on how much 
video is on the disc and the speed of your Mac. Apple says you can figure roughly 2 to 3 minutes of encode/burn time per 
minute of video on the DVD. So a DVD with 90 minutes of video on it (the maximum allowed), might take as long as 
4.5 hours to encode and burn.

If your movies have been sitting in iDVD the whole time you've been working on this 
project, the encoding is already done. We'll talk more about encoding in Appendix B.

Several readers have reported that burning a DVD fails unless they wait for all of the 
assets to be encoded before clicking the Burn button. Click the Status button in the 
Customize drawer to see how far along encoding has progressed, then wait for all the 
assets to be "Done" before clicking the Burn button.

If a burn fails and you've tried everything else I've suggested, here are two more things 
to try:
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iDVD requires a certain amount of free space on your hard drive or it chokes, 
so get rid of some stuff if your drive is full or nearly full.

1.

Optimize (defragment) the disk containing the iDVD project.2.

Remember, this chapter is merely a hands-on introduction. You're going to spend a lot more time customizing themes, 
menus, and buttons in upcoming chapters, but for now, you know enough to burn a decent disc if you had to. And enough 
to plan a more-than-decent disc if you wanted to.

And that's the end of that. Shall we move along now? It's time for tips, techniques, and advice about shooting and editing 
video for a DVD.


